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The following topics are discussed in this section: GENERAL INFORMATION Microsoft QuickBASIC, version 4.5, is a fully integrated package that includes an editor, a compiler, a linker, and a troubleshooter. You can create programs that run by themselves or using the BASIC library module. GET
STARTED The QuickbasIC package comes with two applications. The first program is the compiler, which creates an executable file from your BASIC source code. To compile and link the source code, use the MSB command followed by the file name, and then press the [ENTER] key. You can also
create executables from the embedded environment. To run the environment, issue the QB command and press [ENTER] . To edit a specific file, enter the file name after the qb command and before pressing [ENTER] . The environment works well with a mouse, so the LAN will automatically load the
mouse driver (if it's not already loaded) before placing yourself in the editor. USING QUICK BASIC When you first perform the environment, you will be placed in the editor. At the top of the editor is the main menu. The line below this contains the name of the file that is currently being edited. If the file has
no name, the word Unnamed appears. On the far right of this line will be an arrow. If the arrow only points up, it means that the editor does not fill the entire screen. To expand the editor window, place the mouse pointer on the arrow and [Left mouse button]. Pointing the arrow in both the up and down
directions means that the edit window takes up the entire editing area. Clicking [Left Mouse Button] on this arrow reduces the window to its size before the window expands. At the bottom of the screen is a reference line. This line contains information such as the name of the line. Above this reference line
is the immediate window. This window is used to test the programs and perform calculations. However, you cannot load files in this window. Each window has scroll bars at the bottom and to the right of its edges. The scroll bars can be used to show where you are in the displayed file and move to a
specific location in the file. Your location in the file is indicated by the location of the black box on the specific scroll bar. If the black box is halfway between the ends of the scroll bar, you are currently viewing the center of the document. To move to a different area of the file, place the mouse pointer on the
desired side of the black box and press [Left Mouse Button]. If the cursor is under the black box, the window moves one page down in the file. If you click over the black box, the editor moves the displayed text one page up. The same method can be used for to move to the right and left of the document.
Using the Main menu menu is located on the top line of the screen. There are several ways to select an option from the main menu. The first and easiest is to place the mouse pointer on the desired option and click the left mouse button. A submenu appears from which you can select the option you want.
Another procedure is to hold down the [ALT] key and press the capital letter of the menu option you want. The third method of selecting a command from the main menu is to press the [ALT] key, and then use the arrow keys to highlight the option you want. Pressing the [ENTER] key while the option is
highlighted performs that command. If you decide that you want a different main menu command than the one you currently selected, use the [Left Arrow] and [Right Arrow] keys to select the new option. Another method is to place the mouse pointer on the new setting and press [Left Mouse Button].
Keyboard shortcuts appear next to certain options in submenus. These shortcuts specify the corresponding keyboard setting for the specific submenu option. To set the setting, press the specified keyboard combination. Using online help There are several ways to view online help. The first is to highlight
the command you are requesting help for and press the key [F1]. You can also select the Help menu, and the menu will present four options. The Index option displays an alphabetical list of all the keywords in QuickBASIC. For help with a specified keyword, place the cursor on the specified keyword and
click [Left Mouse Button] . The Content option displays a list of categories that you can select for additional help. The Subject option displays Help for the keyword under the cursor in the edit window. If the cursor is not on a word, this option is not available. The Help option in Help explains how to use the
online help feature. When an item appears, a menu appears at the top of the help window. To select any of the menu commands, place the cursor on the command you want and press [Left Mouse Button]. At the end of the help information will be a list of related keywords. You can see help for one of
these keywords by selecting it with your mouse or by using the [TAB] key. Press [ESC] to end the help. This removes the help window and places the cursor back in the edit window. Help is also available for symbols in your own application. For example, if you want to see what type of variable was, you
can place the text cursor on the variable and press [F1] . QuickBASIC provides the ability to print the online help to a printer. To do this, select the file | Print command from the main menu, while the Help window is the active When you select this command, a dialog box appears with options. Den Den
The text option prints only the text that is selected. The Active Window option prints the contents of the active window. The Current Module option prints the contents of the window that you are currently viewing. The All Modules option prints the contents of all programs loaded into memory. Many of the
commands specified in the Online Help help come with sample programming code. QuickBASIC allows you to copy this code from the Help window to the program. To do this, display the sample code you want in the Help window. You can then use the cutting and pasting facilities mentioned later in this
guide to copy the selected text from the Help window to the program. Dialog boxes that use dialog boxes appear each time you select a menu command that is followed by three dots. They are used to get information from you so that the specific command can be executed. Dialog boxes are divided into
multiple boxes. The first type of box is a text box that you use to get a string you type on the keyboard. The List field contains a list of options from which you must choose. The command buttons usually appear at the bottom of the dialog box. Buttons can be activated by positioning the cursor on them,
and then pressing [ENTER] or [Left Mouse Button]. Option buttons show a small dot if the setting is active. Check boxes show an X if the option is selected. Exiting the QuickBASIC Option to exit QuickBASIC is on the File menu. To exit, select the File menu options, and then exit the menu items (File |
Exit). If changes have been made to your application since last saving, QuickBASIC will ask if you want to save the file now. Press [ENTER] to save the file. You'll be prompted to name the file if this is the first time you save the file. Manipulation of Windows QuickBASIC has four window types in the
environment. The first type is the View window. The View window is where most of the programming is done. The Immediate window is the second type and is used to test a line of code or perform calculations. The help window appears when online help is requested. The fourth window is called the Value
Clock window and is where the values for specified variables appear while you troubleshoot the program. QuickBASIC only allows you to use one window at a time, although more than one can appear on the screen. The window you are working in is called the active window. The active window is
differentiated by having the title highlighted. To make another window the active window, press the key [F6]. This will cycle through all the windows that open in QuickBASIC. Press [SHIFT][F6] to flip backwards through the list. If you're using a mouse, you can make a window active by placing the mouse
pointer within the window boundaries and clicking [Left mouse button] . QuickBASIC provides several ways to configure the windows on the screen. To increase the size window to display it on the entire screen, press [CTRL][F10] . To reduce the window back to its original size, press [CTRL][F10] again.
To expand a window with only a few lines, press the key combination [ALT] [+] for each line you want to add. To reduce the size of a single-line window, press the key combination [ALT] [-] . The [+] and [-] keys represent the plus and minus keys on the numeric keypad. These features require that Num
Lock not be set. It is also possible to configure the size of the window using the mouse. To resize the window, place the mouse pointer in the title bar of the window you want to change. Drag the border to the location you want on the screen while you press [Left Mouse Button]. When you release the



button, the window changes. View window When you load a program from disk or start a new program, the source code appears in the view window. The view window has two markers that track your location. The first is the text cursor, which shows the position where input from the keyboard will be
entered. The second cursor is the mouse pointer. It is used to select commands, display help on the selected word, manipulate the text window, and place the text cursor in a specific location. The text cursor can be moved by typing text or using the direction keys. The [Left Arrow], [Right Arrow], [Up
Arrow] and [Down Arrow] keys can be used to move the text cursor one character left, right, up, or down, respectively. The [Home] and [End] keys can be used to move the cursor to the beginning or end of a line, respectively. If the application is larger than the window, the [PG UP] and [PG DN] keys can
be used to move up and down on one screen in the application. If you press [CTRL] with the [Left Arrow] or [Right Arrow] keys, the cursor moves to the beginning of the previous or next word. [CTRL] is used with the [Home] keys, and [End] moves the cursor to the first or last line that appears on the
screen. When [PG UP] and [PG DN] are used , the cursor moves to the right or left with a screen. Instant Window Window The immediate window appears at the bottom of the screen. Commands in this window are executed when you place the cursor on the command and press [ENTER]. You can put
more than one sentence on a line by separating them with the :. This is useful for testing lines of code before placing them in the program. The Value Clock clock window is used to display the values for specified variables. This allows you to see the values stored in your variables as you review the
program. Because one of the main reasons for application errors is an incorrect value in a variable, this is a useful troubleshooting tool. You can tell QuickBASIC which variables to see by issuing Debug | Add Clock command from the main menu. You must Enter the name of the variable to see.
QuickBASIC then displays the program name, variable name, and value in the Audit Value window (located above the View window). To remove a variable from the Auditing window, select Troubleshooter | The Delete Clock command. To do this, select the Help command from the main menu or press
[F1]. In both cases, QuickBASIC displays the online help associated with the word under the cursor. The help window is divided into two parts. The section at the bottom of the window is called QuickSCREEN and contains the information you want about the command. The top of the window contains
items called hyperlinks. Hyperlinks are connections to another record in the online help system. Hyperlinks will be topics related to what you are currently viewing. To enable a hyperlink, place the mouse pointer on the item you want and click [Left Mouse Button] . You can also use the [TAB] key to move
the text cursor to the item you want and press [ENTER]. If you press [ALT] [F1], you will return to the previous item before you enable the link connection. However, QuickBASIC only remembers the last twenty links, so you can't eat more than twenty connections. Pressing [ESC] closes the Help window
no matter how deep you are in hyperlinks. With quick bassic for copying and wrapping text, you can select a block of text so you can perform an action on it. To select a block of text, place the text cursor at the beginning of the text you want to select, and then hold down [SHIFT] while you press the arrow
keys. QuickBASIC automatically highlights the text when you move the cursor. You can perform the same action with your mouse by placing the mouse pointer at the beginning of the text you want to select. Move the mouse pointer to the end of the block while holding down [Left mouse button].
QuickBASIC automatically highlights the text when you move the mouse. To remove the highlight, press one of the arrow keys or click [Left Mouse Button]. Pressing [DEL] permanently deletes the text from the file. To move the selected text from one location to another in the file, press [SHIFT][DEL] . This
places the selected text in an electronic clipboard. You can then press [SHIFT][Insert] to move the selected text from the Clipboard to the current text cursor's location. Each time you press [SHIFT][Insert], the contents of the Clipboard are inserted into the program. To copy the selected block, press
[CTRL][Paste] to copy the block to the Clipboard. You can then press [SHIFT][Insert] to insert the clipboard contents into the file in the text cursor's location. Text placed on the Clipboard remains there until a new in the Udklipsholder. You can also a block of selected text. To do this, first select the block of
text to replace. Then type the new text to replace the selected area. As soon as you press a key, QuickBASIC automatically deletes the selected text and inserts the new text you type from the keyboard into that location. Opening and starting a new file To start a new program, issue the file | New Program
command. If a program is currently loading in the View window, QuickBASIC asks if you want to save the changes before clearing them from memory. The Create File command is used to create a new file that is part of the current program in memory. This is useful for creating separate libraries or
modules. When this command is selected, a dialog box appears. In this field, enter the name of the file to create and tell us what the file type should be. A module is a collection of BASIC commands. A tag file is a text file whose contents are located in the application after $INCLUDE metacommand is
found. A document file is a simple ASCII text file. File | The Open Program command is used to load a previously saved program in the View window. QuickBASIC can open files stored in either ASCII or QuickBASIC formats. After this command is issued, a dialog box appears where you can select the
file to open. To select a file, place the mouse pointer on the file name you want and double-click [Left Mouse Button] . If you change the file pattern in the File name box, the files that appear in the File window change. If the file to load is on a drive or subfolder other than the current one, place the mouse
pointer on the drive letter you want in the Dirs/Drive box and double-click [Left Mouse Button]. The Load File command loads the specified single module, tag, or document file that is in memory. You can specify the name of the file and its type in the dialog box that appears when you select this command.
After a file has been loaded into memory, you cannot load it again until you have selected the Remove File command to remove the file from memory. The Merge command can be used to place the contents of one file in another. If you issue this command, a dialog box appears. From this field, select the
file you want to load. When you press [ENTER] after you type the file name, the contents of the file are placed in the current text cursor location in the current program. Saving the program There are several ways to save the application to a disk. The preferred method is to issue the file | Save command.
This command saves the file to the disk in QuickBASIC format. If the file has not been previously saved, a dialog box appears requesting a name for the file. If the file already exists, the old version is deleted and the new version is saved instead. Save As command is used to save under a different file
name. When command is issued, a dialog box appears. In this field, type the new name for the file and press [ENTER] . QuickBASIC then saves the file under the new name and in QuickBASIC format. To save the file in an ASCII text format, place the mouse pointer in the Text option and click [Left
Mouse Button] . Files stored in this format can be read by other programs, such as the Save All command used to store all files that are loaded into memory. This is useful for saving changes to modules and including files that can be loaded into memory with your main program. This command
automatically replaces all old versions of the files when they are saved. Printing the QuickBASIC application is a facility for printing the applications. To print the program, all loaded files, or a section thereof, use the file | Print command. When this command is issued, a dialog box appears. In this box, you
can specify which items to send to the printer. If you select the Selected Text option, all text currently selected in the active window is sent to the printer. The Active Window option sends all text in the active window to the printer. The printer receives the application in the current window when you select
the Current Module option. To print the entire program and all its loaded subprograms, select the All Modules option. After selecting the group you want to print, click [Left Mouse Button] on the &lt; OK &gt; button, or press [ENTER] to have the text sent to the printer. The View menu contains options for
viewing different application components, as well as moving files in and out of the View window so that they can be edited. One of the more useful views is that of your application output. Press [F4] to see the output screen. Press [ESC] to return to the program. The view | The Next Statement option
moves the cursor to the next source line to execute. The Split option is used to split the Show Horizontal window. The first two options on the View menu support subroutines. If you press [F2], a dialog box with all the loaded modules and subroutines appears. To edit one of these routines, place the
mouse pointer on its name and click [Left Mouse Button] . To view the file in the View window, in the Edit in Active option, click [Left Mouse Button]. If you click [Left Mouse Button] on the Split Edit option, the Show Horizontal window and the selected file are split in the new split window. The Move option
displays a dialog box from which you must select the destination module to move the originally selected procedure. In the list, QuickBASIC will place module names in capital letters, and procedures will be indented under their respective module and only get their first characters capitalletters. Taps Press
will display the next alphabetical procedure in the View window. QuickBASIC also provides facilities for viewing and editing files with the last two commands in the View window. With the text cursor on a line that contains a $INCLUDE, the included file in the View window is placed in the View window if
you select the Included File command. The Included Lines command is an on/off file that allows or does not allow editing of the included files. When this option is on, a dot to the left of the command appears on the View menu, and you will not be allowed to edit the file. To edit, press [ENTER] twice.
Searching and replacing text QuickBASIC provides a sophisticated search and replace mechanism. To search for a specific string, open the search prompt by pressing [ALT] [S] [F] . You will then be asked for the string to find. Enter the string and press [ENTER] . QuickBASIC highlights the next
occurrence of the specified string. Pressing [F3] highlights the next instance in the file. When the end of the file is reached, QuickBASIC automatically continues searching at the beginning of the file. Replacing text works the same way as searching for text. To replace text, press [ALT] [S] [C] to display the
text change query box. In the query field, type the string you want to replace. Then press the [TAB] key and specify the string you want to use to replace the old text. When both fields are specified, press the [ENTER] key. QuickBASIC then searches for the specified string and highlights it when it exists.
QuickBASIC will then ask if you want to change the current finding. If you do, press the [ENTER] key. QuickBASIC will then continue the search, asking you with each find if you want to change the text. QuickBASIC provides many options for searching and replacing operations. The first time you request
a search, two options appear to the left of the dialog box. If you click [Left Mouse Button] in the Fit Case option, QuickBASIC highlights only the strings that match the exact case of the specified search string. The entire Word setting forces QuickBASIC to match the string only if it is a complete word, i.e.
not part of another word. In the Search box, you can specify which windows to search in. The All Modules option searches all programs loaded into memory. When you perform a change action, you also have several options. At the bottom of the query field will be some options to control the change. The
Search and Confirm option finds each instance and asks you to Change. This is the default setting when you press [ENTER]. The Change All option will automatically find all instances of the search string search string replace them with the change string. When the first selection is found and you have set
the Find and Confirm option, you will be asked if you want to make the change. At the bottom of this window will be a list of options. The Shift option makes the change and continues searching. The Skip option skips this instance and search for the next one. The Cancel option ends the search operation.
Another search option is Search | Label command. This menu command allows you to search the program for a specific label. When you enter the label name and press [ENTER], QuickBASIC highlights the label and moves the text cursor to the label's location in the program. Using Smart Editor
QuickBASIC's editor provides a special feature called smart editor. Each time a new line is entered in the editor, the editor cleverly checks the syntax error line, formats the line as needed, and aggregates the source line in memory. Smart editor is turned on by default. To disable the smart editor so that
you can write a document or data file, select the document option after issuing a file | Create file or file | Load File command. When the line you entered contains an error, the smart editor displays an error message. Pressing [ESC] clears the message and places the cursor in the position in the line where
the error occurred. The program will not run until all syntax errors are corrected. The smart editor does not mark a misspelled command as an error because it requires you to define a new subroutine. After you press [ENTER] on a line without syntax errors, the smart editor automatically converts all
BASIC keywords into uppercase letters. It also corresponds to uppercase letters of variables that you previously defined or used. It will insert spaces before and after all the basic operators and adds punctuation in places where you forgot to place it. Running a program after the program is entered, try to
do so. To run the program, press [SHIFT][F5] or select Run | Start the command from the main menu. If there are no errors in the program, QuickBASIC automatically starts executing the program. If an error is found, QuickBASIC displays a message that describes the error and highlights the error in the
program. If there is more than one error, correct the first error and try running the program again for QuickBASIC to show you the error. Official Journal | The Restart command clears all variables and runs the program. This is useful if you want to run the program from the beginning instead of continuing
from the current location. The Continue option continues to run the program from the last runpoint. By default, QuickBASIC does not create an executable file. However, you can create one by selecting the file | Make the EXE File command. A dialog box appears where you can Settings. The first is is is
the name of the executable file. By default, it will be the same name as the main module. If you check data error code for products, place special troubleshooting information for use with Microsoft Code View in the executable file. This option also activates the sequence [CTRL][Break] while running. The
default executable file requires the use of BRUN45. The EXE file in your computer's search path to run. To create an independent executable file, in the Standalone EXE File option, click [Left Mouse Button]. After you set the options you want, click [Left Mouse Button] in the Make EXE or Make EXE and
Exit option. Troubleshooting a program Sometimes your program will run without QuickBASIC saying there are errors but it is not running properly. QuickBASIC provides some troubleshooting tools to help you find these runtime errors. The first is the [F7] key. When you press this key, the QuickBASIC
program runs up to the line that contains the text cursor. Pressing the key [F8] performs the next line of code in the program. This is useful for crawling the program one line at a time when you are trying to find an error. If the next line is a procedural call, [F8] is going through the procedure. [F10] works in
the same way as the [F8] key, except that it performs procedure calls as if they were a statement. If you want to specify specific lines where you want to stop the execution, you can place a break point. A break point tells QuickBASIC to stop the program so you can examine your variables. Pressing [F9]
places a break point on the current line. To mean a breakpoint, QuickBASIC will change the color of the line in the program. Press [SHIFT][F5] to run the program until the breakpoint. If you press [F9] on a line that already contains a breakpoint, QuickBASIC removes it. You can also select Debug | Clear
all the Breakpoints menu to clear all breakpoints throughout the program. QuickBASIC provides another kind of break point called a clock point. A monitoring point specifies a specific condition that causes application execution to stop so that you can examine the values for your variables. A monitoring
point is set using Troubleshooting | Watchpoint command. Enter the condition and press [ENTER] . The condition is placed in the watch window and is followed by either &lt; FALSE&gt; or &lt; TRUE&gt; depending on the result of the condition. When you run the program, QuickBASIC stops performing the
application when the condition becomes TRUE. Most runtime errors occur because a variable has an incorrect value. To see the values for certain variables, you can specify a clock. You can do this by selecting Debug | Add Clock command from the main menu. QuickBASIC will then ask for the variable
you want to see. Enter the variable name, then press [ENTER]. QuickBASIC displays the name and value of the variable in the Clock window. troubleshooting | Delete Clock command. QuickBASIC displays a list of all the watch variables. Use the arrow keys to highlight the clock to delete and press
[ENTER] . Choice of debug | The Delete All Watcher command removes all clocks from the Clock window. The Track option reviews the application in slow motion, highlighting the line that is being executed while it is running. The Set Next Statement option highlights the next command in the application
to execute. The Error Break option stops the runtime when an ON ERROR statement is activated. Another option on the Debug menu is the Overview to option. This option records the last twenty lines of the program that were executed so that you can track the last statements that were made before
QuickBASIC finished the run with a runtime error. To go backwards through this list of commands, press [SHIFT][F8] . To proceed through the history list, press [SHIFT][F10] . If you press [SHIFT][F9], the Instant Audit dialog box appears. In this field, you can enter a variable whose value you want to
examine. When the dialog box appears, you are prompted to evaluate the expression. When you press [ENTER], QuickBASIC displays the value in the Value field. If you click [Left mouse button] on the Add Monitor button, the variable is added to the variable in the Clock window. This is useful for finding
the calling sequence of nested procedure calls when a program crashes. The current procedure appears at the top and the oldest at the bottom. The record at the bottom of the call stack will be your primary program. Basic commands can also be used for troubleshooting. Commands such as STOP,
PRINT, CONT, TRON, and TROFF are useful for tracking the flow of an application. Function key definitions The following table provides a brief description of the functions assigned to the specified function key combinations. Brief description of keys ---------------------------------------------------------------------
---------- [SHIFT][F1] Displays a general help screen [F1] Displays help on the word under cursor [ALT][F1] Displays a previous help screen (up to 20) [F2] Displays a list of SUB or FUNKTIONsfileres [SHIFT][F2] Displays it next procedure [CTRL][F2] Displays the previous procedure [F3] Finds the next
occurrence of the specified string [F4] Displays the output screen [F5] Continues application execution after stopping [SHIFT][F5] Running the program from the beginning [F6] Enables the next window [SHIFT][F6] Enables it previous window [F7] Running the application up to the current cursor position
[F8] Executes the next command or spurs in a procedure [SHIFT][F8] Step back through the application if Overview on [F9] sets or removes a breakpoint Displays the Instant Audit [F10] Running next command or procedure [SHIFT][F10] Step forward through the application if Overview on [CTRL][F10]
Switch between window and full-screen view Conversion of BASICA applications QuickBASIC accepts most applications written in DOS's BASICA and GW-BASIC. To load a program written with DOS BASIC in QuickBASIC, you must have DOS BASIC save the file with,A option. This saves the file as an
ASCII file so that QuickBASIC can load the file into memory. If the A option is not specified, the file is saved in a compressed format and cannot be read by QuickBASIC. QuickBASIC does not support all commands available in DOS BASIC. Commands that interface a cassette player and edit the source
application are not allowed, as cassette players are no longer used with PCs and QuickBASIC provides its own editor. These commands are not supported: AUTO, CONT, DEF USR, DELETE, EDIT, LIST, LLIST, LOAD, MERGE, MOTOR, NEW, RENUM, SAVE, and USR. The following statements are
supported in QuickBASIC but require changes: BLOAD, BSAVE, CALL, CHAIN, COMMON, DEFtype, DIM, DRAW, PLAY, RESUME, and RUN. Compilation and linking from DOS QuickBASIC also includes programs that allow you to create executable files from the DOS prompt. This way, you can use
your favorite text editor to create the programs. After you save the program with the text editor, compile and link it to create an executable file. To do this, specify the MSB command name where the file name is the name of the source file. Press [ENTER] to accept the default object file name. To have a
list file produced, enter the name of the program followed by [ENTER] . If you press [ENTER], QuickBASIC asks not to create a list file. If there are no errors in the source code, the link runs automatically to convert the object code to an executable file. If errors are found, they appear on the screen along
with the corresponding line number. You can also use the history file (if you requested that one be created) to find the errors. When the link is run, it will first ask you for the executable file name. To select the same name as the source code, press [ENTER] . Next, it will ask for the name of the card file. If
you do not produce troubleshooting information in executable, press [ENTER] to specify that no card file should be produced. The next question that links is for all libraries used by the program. If the program uses libraries, enter their file names here. To make a standalone executable, enter the library
name BCOM45. If you do not specify this the executable does not run without using the microsoft runtime library executable. USEFUL TIPS When it comes to long applications, it is useful to use placemakers to specific locations in the program. To select a line, place the text cursor on the line and press
[CTRL][K] followed by a place number. To go to the placemark, press [CTRL][Q] followed by the location number you want. When working on machines with mathematical coprocessors, it is best not to place calculations in a state. In these situations, the result of the calculation is stored in the mathematics
coprocessor's records and may be more accurate than the comparison allows. Q Q. Can I still use line numbers in my BASIC programs with QuickBASIC? A. Yes, QuickBASIC allows it, but does not require the use of line numbers. REFERENCES/MANUALS For a complete list of QuickBASIC commands
and settings, see the Microsoft QuickBASIC manual. Your local bookstore must have third-party programming reference manuals in Microsoft QuickBASIC. EXAMPLES INPUT How old is your pet? , age INPUT What is the name of your pet? , petName$ SELECT CASE CASE IS &lt; 0, ER &gt; 100
PRINT I guess it does not case 1 to 3 PRINT Ahh, just a baby SAG 4.6.8 PRINT Young, even aged animal SAG ELSE PRINT Pretty stupid example, I admit THAN SELECT FOR LOOPVar = 1 TO AGE PRINT We want ; petName$; Happy birthday! NEXT (c) Copyright UCF Computer Services I&amp;R
Support 08/25/93 08/25/93
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